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DISCLAIMER OF ALL WARRANTIES AND LIABILITIES 

Academic Software, Inc., and its suppliers make no warranties, either express or implied, with respect to 
this user's guide or with respect to the software described in this user's guide, its quality, performance, 
merchantability, or fitness for any particular purpose. In no event will Academic Software, Inc., or its 
suppliers be liable for direct or indirect, incidental, or consequential damage resulting from any defect in 
the software, even if Academic Software, Inc., has been advised of the possibility of such damages. Some 
states do not allow the exclusion or limitation of implied warranties or liabilities for incidental or 
consequential damages, so the above limitation or exclusion may not apply to you. 

 

COPYRIGHT INFORMATION 

This manual and software are copyrighted and may not, in part or in whole, be copied, reproduced, 
translated, or reduced to any electronic medium or machine readable form without prior consent in writing 
from Academic Software, Inc., other than for personal use and backup copies. 

 

 

 

Windows and .Net Framework are trademarks of Microsoft, Inc. Adobe Acrobat Reader is a trademark of 
Adobe, Inc. SS-Demo, Dino-GAMES, Multi-SCAN, SS-ACCESS, and WinSCAN are trademarks of 
Academic Software, Inc. 

 

A PORTION OF THIS MATERIAL IS BASED UPON WORK SUPPORTED BY THE US DEPARTMENT 
OF EDUCATION UNDER CONTRACT NUMBER RW-95170005. ANY OPINIONS, FINDINGS, 
CONCLUSIONS, OR RECOMMENDATIONS EXPRESSED IN THIS PUBLICATION ARE THOSE OF 
THE AUTHORS AND DO NOT NECESSARILY REFLECT THE VIEWS OR POLICIES OF THE US 
DEPARTMENT OF EDUCATION. 
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Welcome to... 

SS-ACCESS for Windows 

 
SS-ACCESS for Windows is designed especially for new Windows software from ASI 
and other publishers who provide built-in single-switch scanning and control. 
Choose a keystroke, function key, combination key command, or mouse click to be sent 
to the single-switch application each time the user presses the switch. The switch repeat 
rate and dwell time (i.e., activation delay) can be adjusted easily to suit the user. 
 

 
 

SS-ACCESS for Windows is as easy to use as ... 

1. Insert the SS-ACCESS Software flashdrive into a PC USB port. Open the SSA 
Publish folder and double-click on the setup.exe file. Follow the screen instructions 
to install the software on your hard disk.1 

2. Plug your switch into the SS-ACCESS USB Adapter. 
3. Plug the SS-ACCESS USB Adapter interface into a PC USB port. 

From then on ... 
4. Click on the SS-ACCESS Desktop icon to run the program. 
5. Using the Settings menu, Define a switch Action appropriate for the single-switch 

program you are going to operate. 
6. Optionally choose Save to save your current settings and window location for the next 

time the SS-ACCESS program runs. 
7. Choose Run from the File menu to start SS-ACCESS. 
8. Run your single-switch program, click inside its window to give it the focus, and 

operate it with your switch. 
9. When SS-ACCESS is running, to return to the Setup Window, click the SS-ACCESS 

program icon that appears in the Windows Task Bar. To quit, press Ctrl-Q. 
  

																																								 																					
1  Refer to the Technical Notes section of more information about installation. 

SS-ACCESS is a single-function, single-switch interface solution for 
your PC running Windows 8 or 10+. It is designed to be easy to 
install, simple to use, and compatible with the widest range of 
computers and application software programs. 

QUICKSTART  
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The SS-ACCESS software is distributed on a USB flashdrive. This flashdrive contains a 
folder named SSA Publish containing a file named setup.exe. Double-click this file to 
run the Installer and follow the instructions and prompts to complete the 
installation. A shortcut program icon to run the SS-ACCESS program will be 
placed in the Windows START SCREEN APPS list and on the Desktop.2 

 
You are finished with the software setup! 

 

 
 
The SS-ACCESS USB Adapter interface is a small box with a USB plug on one end and a 
standard 3.5 mm phone jack for the adaptive switch on the other end. 

 

The interface adapter can be plugged directly into a PC or laptop computer USB port or 
into a USB extension cable or a USB hub that itself is plugged into such as port. 
 

You are finished with the hardware setup! 
	

 

	 	

																																								 																					
2  To uninstall the SS-ACCESS software, use the Programs and Features tool and the Add/Remove 

Programs option available from the Windows Control Panel. 

SOFTWARE  

HARDWARE  

The SS-ACCESS USB Adapter protrudes some distance beyond your PC. 
Added to that is the switch plug and cable which insert in the jack at one 
end of the adapter. Use care not to apply sideways forces or jiggle the 
adapter when plugged into the USB jack on your PC. Use of an 
extender cable or small USB hub is recommended if you plan to 
frequently swap different types of switches for user testing purposes. 
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To run SS-ACCESS for Windows, double-click on the Desktop program icon or select 
the program using the Windows START SCREEN APPS list (found under the 
subheading Academic Software, Inc.). This will open the Setup window and display all of 
the current settings. 

 

 

The Setup window provides three menus: File, Settings, and 
Help. Use the File menu option or the appropriate shortcut key 
combination to run SS-ACCESS, save the current settings for 
automatic recall the next time the SS-ACCESS program starts, 
print the Setup window, or quit the program. 

When Run is selected, the Setup window is minimized as an icon shown in the Windows 
Task Bar at the bottom of the screen. From this point on, pressing the external switch 
sends the "Switch Action" command to whichever Windows program currently is active 
and has the focus. For instance, if the switch action is set to "ENTER", pressing the 
switch will have the same effect as pressing the ENTER key on the keyboard. 

 

	 	

OPERATION  

To quit SS-ACCESS when the program is running, click on the SS-
ACCESS icon in the Windows Task Bar at the bottom of the screen to 
restore the Setup window and select Exit from the File menu. 
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On startup, SS-ACCESS automatically loads previously saved settings and attempts to 
locate the SS-ACCESS USB Adapter switch interface. If this fails, an alert message will 
appear. Likewise, if the adapter is located but a switch is not plugged-in, a different alert 
message will appear. The Setup window will show that the SS-ACCESS USB Adapter 
is Off-Line and that the Switch Test status is Unknown. Under these conditions, SS-
ACCESS for Windows will not run. The user is directed to check that both the USB 
adapter and the adaptive switch are plugged-in properly. 

Normally, however, assuming the adapter and the switch are connected appropriately, the 
Setup window will show that the SS-ACCESS USB Adapter is On-Line and that the 
Switch Test shows Not Pressed. The external switch may be tested simply by pressing 
the switch. This should toggle the Switch Test message Not Pressed to Pressed. 

 

 
 

Use the Settings menu to Define a switch Action function for the 
external switch and/or set switch activation options. 

Click Tone ON or OFF to activate or deactivate an audible tone 
response when the external switch is pressed. Use the Windows 
Volume Control to adjust the loudness of this standard tone. 

The Repeat Rate dialog box turns the repeat delay off (ASAP) or sets the time delay 
between repeats of the switch action if the external switch is held depressed. For users 
who have difficulty releasing the switch, no repeat delay (ASAP) undoubtedly will send 
commands too quickly for some software. A solution is a delay rate equal to 1 second. 

The Dwell Response dialog box turns OFF or sets an activation delay after the switch is 
released and before the switch action occurs. This feature provides time for the switch user 
to shift his or her attention from the switch to the display screen where the action occurs. 

  

TESTING  

If SS-ACCESS can’t find the USB switch adapter or Test Switch doesn’t 
work, the adapter and/or switch may not be plugged-in properly. For 
solutions, check the connections first, visit our Frequently Asked 
Questions page on the Internet at http://www.acsw.com, email us at 
asistaff@acsw.com, or call us at 1-859-552-1020 for technical support. 

SETTINGS 
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The Define Switch Action dialog box shown below identifies what function will be 
emulated by the switch. Select a radio button to emulate a mouse click function. Select 
the Key Stroke button and press a single key (e.g., ENTER, SPACEBAR, TAB, a, b, c, 
F9, etc.) at the prompt to emulate a single keyboard command. Select the Combination 
Key button and press a single key at each of two prompts to define a two-key 
combination command (e.g., Ctrl+Q, Shift+A, Alt+F4, etc.). Click OK to accept the new 
Switch Action and return to the Setup window. 

	

The small Help button in the upper left of the Define Switch Action dialog box provides a 
reminder message to choose a function appropriate for the single-switch application 
program to be controlled by the switch. 
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A demonstration program is provided for you to test the use of your switch with SS-
ACCESS by defining your Switch Action to emulate the ENTER key or the Alt+S key. 
Install this program from the SS-Demo Publish directory on your SS-ACCESS 
Software flashdrive by double-clicking the setup.exe file and following the on-screen 

instructions. Windows will add an icon for it to the Windows START SCREEN 
APPS list and to the Desktop. To run this demo, double-click its Desktop icon. A 
scene will appear and music will play. Along comes a character moving left. 

Press your switch to stop the character. Another press of the switch will paste the original 
character in place and begin moving a copy of that character to the left. Continue pressing 
the switch to paste and move as many characters as you wish!3 Use mouse clicks or the 
regular keyboard to enter other commands: e.g., press Alt+A to view the program credits 
and other options or Alt+Q to quit. 

	 	

																																								 																					
3  After 20 characters are added, the display starts over. The window can be resized. Press the Alt key to 

reveal the underlined hotkeys. SS-Demo should work with most other single-function single-switch 
interfaces as well and can be controlled fully with advanced multi-function single-switch interfaces such 
as WinSCAN 3.0 CS, also available from Academic Software, Inc. 

SS-DEMO 
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To install SS-ACCESS using the ClickOnce Installer program: A ClickOnce setup.exe Installer is a 
special program provided by Microsoft to install ClickOnce application programs "safely" on Windows 
computers. In addition, the Installer places an "application reference" shortcut icon (that points to the 
ssaccess.exe program wherever that is installed) in the Windows START SCREEN APPS list and on the 
user's Desktop. Further, it facilitates completely removing the program using the Windows Add/Remove 
Programs tool. 

To install SS-ACCESS on your computer, 
open the SSA Publish directory and 
double-click on the setup.exe file. This 
will evoke the Application Install window 
shown here. ClickOnce applications are 
"signed" and certified programs. They can 
use an official registered "certificate" 
from a certification guarantor or they can 
use a company-signed certificate. In the 
former case, the Publisher field identifies 
the company that paid the certification 
guarantor for that service. In the latter 
case, the Publisher field is "Unknown 
Publisher". Academic Software, Inc. uses 
a company-signed certificate. If you trust 
that your software came from ASI or its 
distributors, then click Install to proceed and follow any further prompts. Otherwise, you can not use the 
ClickOnce Installer. 

To copy and/or run SS-ACCESS manually as an ordinary executable Windows program: If you 
choose not to use the Installer, copy the entire SSA Release directory (with all of its files) from your 
flashdrive to your Desktop or to your hard drive (e.g., into a c:\ASI directory that you create for ASI 
software). It would be a good idea at this time to right-click on the SS_ACCESS.exe file in the SSA 
Release folder you copied and select the Create shortcut option. Then move the resulting shortcut icon to 
your Desktop. You can run SS-ACCESS by clicking on this shortcut icon or by opening the c:\ASI\SSA 
Release directory folder and double-clicking directly on the SS_ACCESS.exe program file. (You can also 
run SS-ACCESS the same way directly from your SS-ACCESS Software flashdrive itself.) 

To copy and print this User's Guide: This User's Guide is distributed on the SS-ACCESS Software 
flashdrive as a PDF file. It is also a part of the SS-ACCESS program files and can be called up from within 
SS-ACCESS through the Help menu or by using the Ctrl-H command key sequence when the SS-
ACCESS Setup window is displayed. As a PDF file, the free and widely available Adobe Acrobat Reader 
or some other similar PDF file reader program is required as a default program to open PDF files such as 
SS-ACCESS Users Guide.pdf. If need be, we suggest that you visit the Adobe website at 
https://get.adobe.com/reader and download this free program. Adobe Acrobat Reader provides many 
options for reading and printing PDF files, including double-sided booklet formats. 

SS-ACCESS for Windows requires .Net 4.5.1 Framework: Windows, since version 7, comes equipped 
with .Net and will update that as needed automatically over the Internet. Thus for installation, an Internet 
connection may be required. You may need administrator access to your computer for this. 

  

TECH INFO  



	 	8	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

DEVELOPMENT TEAM: 
Warren Lacefield and Penny Matthews 

PROGRAMMING: 
Warren Lacefield 

 
Copyright © 1997, 2001, 2016 Academic Software, Inc. All rights reserved 

	

Download our latest catalog! 

Training games for children 2-6 years old. 

A single-switch activity center for home and school. 

The programmable, multi-function, single-switch 
interface for PCs with Windows 8 or 10+. 

Surf the Internet with WinSCAN and your switch. 
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